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INFLUENCE OF NATURAL CONVECTION DURING DENDRITIC ARRAY 

GROWTH OF METAL ALLOYS 

 (GRADIENT FREEZE DIRECTIONAL SOLIDIFICATION) 

SUYOG MAHAJAN 

ABSTRACT 

Purpose of this study was to examine the microstructural evolution of primary 

dendrites during “Gradient Freeze DS process” in cylindrical Pb-5.8% Sb alloy samples 

to generate the ground- based research data to support a future microgravity experiment 

on the Space Station in a convection free environment. Pb-5.8Sb was selected for this 

study because of its ease of processing and availability of physical property data which 

will be required for predicting the dendrite morphology parameters, such as, primary 

dendrite spacing and dendrite trunk diameter. This alloy is also susceptible to 

thermosolutal convection caused by density inversion of the met in the mushy-zone 

during DS with melt on top and solid below (gravity pointing down). Two furnace 

cooling rates, 0.5 C/min and 4 C/min were utilized during the gradient freeze DS. 

Morphology of primary dendrites was observed to change from being branch-less 

(cellular) in the very beginning of DS, to those showing onset of side-branching, and 

finally to well-branched tree-like structure having tertiary and higher level side-branches 

as the solidification progressed from the cold to the hot end of the samples. Extensive 

macrosegregation was observed along the DS length, initially being solute poor and then 

becoming more and more solute rich as the solidification progressed. Experimentally 

observed primary spacings are smaller and the trunk diameter larger than those predicted 

from theoretical models which assume purely diffusive transport during solidification.
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CHAPTER I 

INTRODUCTION 

1.1 Directional Solidification (DS) of alloys 

Metal alloys are the combination of metal and metal or non- metallic element.  

Casting is a manufacturing process by which liquid metal poured into a mold is allowed 

to solidify. During directional solidification (DS) the heat is extracted from one end of 

the mold and the solid-liquid interface moves from one end of the casting to the other in a 

directional manner. The grains get aligned along one direction during DS, as opposed to 

the randomly oriented grains forming in the usual casting, aligned grains provide greater 

high temperature creep resistance along their longitudinal direction. This becomes 

especially useful for the gas turbine engine blade components in modern aerospace or 

land-based power turbines, as these rotating blades are the most stressed high temperature 

components in an engine [1]. 

During typical DS process a mushy zone forms between the bulk liquid which is 

yet to solidify and the portion that is already solidified. Fig. 1 shows a typical mushy-

zone formed during DS of a transparent metal analogue alloy, succinonitrile-0.9% water. 

Here, the transparent phase is liquid, and the opaque tree-like phase is the primary 
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solid. The trees, called primary dendrites, extend from their base at the alloy eutectic 

temperature to their tip at the liquidus temperature. The hot bulk melt is above the mushy 

zone and the cooler already solidified portion is below the mushy-zone. If a constant 

thermal gradient is maintained during directional solidification, then the mushy-zone 

length remains constant along the length of sample as is solidified from one end to the 

other. The last liquid to freeze in the inter-dendritic region at the tree-bottoms is of the 

eutectic composition (CE), which when solidified results in a microstructure made of two 

finally distributed solid phase (and often forming alternating plates of and  

For a constant thermal gradient, the liquid-solid interface is planar at very low 

growth speeds, it develops fingers of solid protruding solid phase (cells) at slightly higher 

growth speed. These fingers develop side-arms (called secondary branch) as the growth 

speed increases. At still higher growth speed higher order branches form (tertiary etc.) 

and the primary dendrite gains a well-branched tree like morphology [2]. Two important 

dendrite array morphology features, the primary dendrite spacing () and the primary 

dendrite trunk diameter (TD) are also indicated in Figure-1.   

 
Figure 1. Succinonitrile – 9 wt. % Water “Transparent alloy” directionally solidified (~ 

5μm s- ,~30Kcm-1) (Dr. Grugel, NASA-MSFC) 
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A typical transverse section of the primary dendrite array in DSed Pb-5.8Sb alloy 

is shown in Figure 2(a). The orthogonal nature of the branching is a consequence of (111) 

planes having the lowest liquid-solid interface free energy in face-centered cubic metals 

[3]. As explained above these side-arms develop their own braches as typically shown in 

the transverse view of one Pb-5.8Sb alloy primary dendrite in Figure 2(b).  

 

(a) 

 

(b) 

Figure 1. Transverse view of, (a) Side Arms of Primary Dendrite in DSed Pb-5.8 Sb alloy 

and (b) Secondary, tertiary, and higher order branches in a typical DSed Pb-5.8 Sb alloy.  
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1.1.1. Directional Solidification Methods 

Directional solidification can be carried out by two different procedures, “Steady 

State DS” and “Gradient Freeze DS”. For this research we selected the Gradient Freeze 

DS process.  

1.1.1.1. Steady State DS 

During steady-state DS the thermal gradient (GL) and the growth speed (R) or 

both controlled independently and are maintained constant throughout the solidification 

process [4]. A DS furnace assembly typically consists of a hot-zone on top, and cold-zone 

at bottom, with an adiabatic zone in between. The furnace surrounds the ceramic crucible 

containing the alloy sample. The crucible is held stationary and DS is achieved by 

moving the furnace assembly from one end of the sample to the other. Since, in a given 

alloy the morphology and distribution of primary dendrite trees depend upon R and GL, a 

constant dendritic microstructure forms along the entire length of the sample during 

steady-state DS. As shown schematically in Figure 4, three different growth speeds 

(typically three different DS experiments) would be required to obtain samples with three 

different dendrite morphologies using steady-state DS.  

 

Figure 2.  Schematic of steady state directional solidification 
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1.1.1.2. Gradient freeze directional solidification 

During gradient freeze process the crucible containing the alloy sample and the 

hot-zone heating the mold are both held stationary [4]. The heat is extracted from one end 

of the crucible while the liquid-solid interface traverses from the cod end to the hot end. 

Here, independent control of R and Gl is not possible.  Only the rate at which the furnace 

is cooled can be controlled. Therefore, R (cm/s) and Gl (K/cm) vary along the sample 

length, their variation itself depends upon the cooling rate (K/s).  As a result, dendrite 

array morphology varies from one end of the casting to the other. The advantage, 

however, is that one sample can yield several dendrite morphologies along the DS length, 

depending upon the furnace cooling rate, as shown schematically in Figure 4.   

 

Figure 3.   Schematic of gradient freeze directional solidification 

1.2. Convection During Directional Solidification 

1.2.1. Thermally and Solutally Stabilizing Growth 

As explained above the temperature at the dendrite array tips, is approximately 

the liquidus temperature (TL) of the alloy (the radius of curvature lowers the equilibrium 
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temperature by small amount) [5], and at the array bottom it is the eutectic temperature 

(TE). With the gravity-vector pointing downwards (as on earth), the temperature effect 

alone is stabilizing against natural convection because the increasing melt temperature 

decreases the melt density. However, the solutal concentration profile depends upon the 

composition dependence of the interdendritic melt for the alloy being directionally 

solidified [5]. Let us recall that for alloys with solute partitioning coefficient (k) less than 

unity, the melt composition in the interdendritic melt varies from solute rich eutectic (CE) 

at the bottom of the array to the solute poor composition (Ct) liquid at the array tips. Ct is 

actually slightly higher than the alloy composition (Co) because of the curvature effect 

[5]. If the alloy is such that increasing solute content increases its melt density, then the 

composition profile in the interdendritic melt is also stabilizing against natural convection 

[6]. This is the case for example with the Al-19 wt% Cu alloy because increasing coper 

content of an aluminum-copper alloy melt increases its density (as shown schematically 

in Figure 5).  

 
 

Figure 4.  Schematic Temperature, Concentration and Density Profiles in inter-dendritic 

Liquid, Al-Cu 

1.2.2. Thermally Stabilizing, but Solutally Destabilizing Growth 

However, if the alloy is such that the increasing solute content decreases its melt-

density, then a density inversion occurs in the inter-dendritic melt and the DS process is 
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potentially susceptible [7] to natural convection, as shown schematically in Figure 6. This 

is the case with Pb-5.8 Sb [8]; the increasing Sb content of a Pb-Sb alloy melt decreases 

its density.   

 

Figure 5.  Schematic Temperature, Concentration and Density Profiles in inter-dendritic 

Liquid, Pb-Sb
8
 

1.3. Convection and Dendrite Array Morphology 

Natural convection occurring in the mushy zone alters the local thermal and solutal 

profiles and hence it influences the dendrite array morphology and their uniformity across 

the cross section of the Directional solidified product. Even in situations where thermal 

and solutal profiles are expected to be stabilizing against natural convection, presence of 

radial temperature gradient causes some primary dendrites to lag their neighbor. When 

that happens the solute rich melt ahead of the leading dendrite begins to flow downwards 

retarding the growth of lagging neighbors even more. This makes the leading edge of the 

dendrite array “steepled” and can lead to severe radial macrosegregation, as for example 

shown in Fig. 7 for an Al-19%Cu alloy [9]. The central region where the leading 

dendrites existed has more primary dendrite trees, but going radially outwards the 

dendrites are very non-uniform. Some of them have unusually long side-arms on their 
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one side. There almost no dendrites in the very outer region, where the microstructure is 

entirely eutectic.  

 
(b) 

Figure 6.  Image of transverse slice of an Al-19 % Cu alloy, grown at 10 μm s-1
7
. This 

depicts an example of transverse phase macrosegregation. 

In alloys, such as, Pb-5.8% Sb where the interdendritic region is solutally 

stabilizing, the low density solute rich melt begins to flow upwards creating “plume type” 

convection, because density of Pb is 11.34 and that of Sb is 6.64 g cm
-3

.  The “plume 

convection” produces an Sb macrosegregation along the DS length of the samples [10], 

and is known to reduce the primary dendrite spacings as compared with theoretical 

predictions [11]. When the neighboring plumes combine together they can create even 

severe defect, called, freckles or channel segregates in the microstructure, as shown in 

Fig. 8 for a Pb-5.8 wt% Sb alloy.  These are the regions where the solute rich melt 

flowing upwards causes re-melting of already solidified side branches of the primary 

dendrites leaving fragmented branch pieces along its path. 
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Figure 7.   Image of transverse slice of a Pb-6 % Sb alloy. This depicts an example of 

channel formation because of plume type thermos-solutal convection. 

1.4. Theoretical Models to Describe Primary Dendrite Morphology 

Because of the numerical complexities to account for mass transfer and phase 

equilibrium existing at the solid liquid interface at length scales which are in 

micrometers, the array dimensions which are in millimeters, and the ampoule dimensions 

where heat-transfer and fluid flows are occurring being in several centimeters, and the 

interdependence of the array morphology, permeability, and convection, it has not been 

possible so far to generate an accurate three dimensional numerical model which can 

predict the effect of convection on the dendrite array morphology. Therefore, the 

theoretical models to predict array morphology features, such as, dendrite tip radius, the 

primary spacing, and dendrite trunk diameter all assume pure diffusive transport and 
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completely ignore the convection effects [12-15]. Effect of convection has only been 

modeled as empirical parameter fit to the experimental data based on very simplistic 

assumptions [16-17].  Two typical diffusive models which predict the primary dendrite 

spacing [18], and the primary dendrite trunk diameter [19] are described below. 

1.4.1. Primary Dendrite Nearest Neighbor Spacing Hunt-Lu [18] Model 

  This semi-theoretical model predicts dendrite tip radius (ρ), primary dendrite 

spacing (λ) and dendrite tip composition (Ctip). This semi-empirical Hunt-Lu model used 

experimental polynomial ‘fit’ parameters and has proven to correlate the microstructure 

observed in a broad range of thermal gradient, growth speed and compositions. For 

primary spacing, this will be the only model used here to compare the experimental 

results. This model uses several dimensionless parameters: 

G′ =
GΓ

(mCo)2  

V′ =
VΓ

DmCo
 

λ′ =
λmCo

Γ
 

Where,  ΔTo =
mLCo(k−1)

k
, G = effective thermal gradient, Γ = capillary length 

(proportional to the ratio of solid-fluid surface energy to the heat of fusion), D = diffusion 

coefficient of Sb in melt, k = solute partition coefficient, Co = initial alloy composition, 

mL = liquidus slope, and λ = Primary dendrite spacing. 

For calculation, all variables are assumed to be constant. The HL model 

predictions with the above parameters are given as: 
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𝜙0

= 6.59𝑟𝑡  

 Curvature Undercooling ΔT′σ 

ΔT′σ = 0.41(𝑉′ − 𝐺′)0.51 

 Tip radius ρ 

ρ =
2Γ

ΔT′σ ΔTo
 

 Primary spacing λ′ 

λ′ = 0.15596𝑉′(𝑎−0.75)
(𝑉′ − 𝐺′)0.75𝐺′−0.6028

 

𝑎 = −1.131 − 0.1555 log(𝐺′) − 0.007589[𝑙𝑜 𝑔(𝐺′)]2 

1.4.2. Primary Dendrite Trunk Diameter Model 

This model developed by Tewari et. al [19] uses the dendrite tip radius predictions 

from the Hunt-Lu model, makes assumptions about the relationship between the tip 

radius and the initial trunk diameter () at the bottom of the parabolloidal shaped tip 

region (till just before the onset of side-branching), and then uses side-branch coarsening 

predicts the dimeter of the dendrite tree at its bottom ().  

  

             Where =initial trunk diameter with rt being the dendrite tip radius, Dl = solute 

diffusion coefficient in the liquid, V = growth speed, G = thermal gradient, Γ = Gibbs-

Thompson coefficient, k = solute partition coefficient, ml = liquidus slope and Co = the 

alloy composition. 

 𝜙3 = 96
𝐷𝑙Γ

𝑉𝐺(1−𝑘)
ln {

1+
𝑉𝐺𝑡

𝑚𝑙𝐶0

1+
𝑉𝐺𝑡0
𝑚𝑙𝐶0

} + 𝜙0
3 
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CHAPTER II 

PURPOSE OF THIS RESEARCH 

The driving reason for this research was the limitations of the equipment available on 

the International Space Station to carry out directional solidification of metallic alloys in 

the low gravity environment of space to compare predictions from the theoretical dendrite 

morphology models with experiments carried out under truly diffusive transport 

conditions. The primary European Space Agency owned facility (LGF) which was 

designed for this purpose is no longer available for future experiments. The question we 

had was, can we achieve the same scientific goals in a much simpler Gradient Freeze type 

of experimental facility which may become available on the Space Station in near future. 

Thus tis research had following goals; 

1. Modify/Fabricate a gradient freeze DS furnace facility which can be used for low-

melting point metal alloys.  

2. Select an alloy suitable for such a study and demonstrate its feasibility by 

terrestrial experiments.
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3. Demonstrate feasibility of generating cellular, cell to dendrite transition, side-

branched dendrites and well-branched dendrites having tertiary and higher order 

branches in one DSed sample. 

4. Investigate experimental parameters, such as, furnace hot-zone temperature, alloy 

composition, cooling rates, thermal profiles, etc. which clearly demonstrate 

natural convection effects on the dendrite array morphology during directional 

solidification. 
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CHAPTER III 

EXPERIMENTAL AND ANALYTICAL PROCEDURES 

1.1. Alloy selection 

The phase diagram of Pb-Sb alloy system [20] selected for this study is shown in 

Figure 9. This alloy system was selected for this study, because, it has been extensively 

investigated by steady-state directional procedure in our laboratory in the past.  

Specifically Pb-5.8 wt% Sb alloy has a low liquidus temperature (288.1 
o
C), therefore 

will need low relatively less power to heat, melt, and provide adequate superheat for 

gradient freeze DS.  Metallographic sample preparation techniques and the equipment 

required for its microstructural characterization are known and available. Thermal 

gradient and growth speed dependence of its primary dendrite spacing have already been 

extensively measured [8,10,11]. The physical properties required to predict the 

processing parameter dependence of primary spacing and dendrite trunk diameter are 

already known for this alloy system (Table-1). It has been shown in prior steady-state DS 

studies that it is prone to the interdendritic “plume” type convection [10]. 
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Figure 8.  Pb-Sb Phase Diagram [20] 

Name Variable Units Value 

Liquidus Temperature TL 
˚
C 288.1 

Liquidus Slope mL K/wt% -6.78 

Solute Partition Coefficient k Dimensionless 0.31 

Eutectic Temperature TE 
˚
C 252.5 

Heat of Fusion Δhf Jm
-3

 2.79 x 10
8
 

Eutectic Composition CE wt% 11.2 

Diffusion coefficient of Sb DL cm
2
/s 5 x 10

-5
  

Gibbs-Thomson Coefficient Γ μmK 0.12 

Table 1 Thermophysical properties of Pb–5.8 wt. pct. Sb used to calculate predict 

primary dendrite spacing and trunk diameter. 
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1.2. Gradient Freeze DS Equipment and Procedure 

     Figure 10 shows the gradient freeze DS facility that was especially 

fabricated/assembled for this research. It consists of a hot-zone (larger diameter feature in 

Figure 10(a)) placed above the heat extracting liquid bath (smaller diameter feature in 

Figure 10(a)) below. The resistance heated hot zone is made of two ring heaters which 

can be independently controlled. The heat extraction bath is a cylindrical water cooled 

vessel containing molten gallium, a detailed view of this is presented in (Fig. 10(b)). A 

ceramic alumina disk having a circular hole separates the heated portion of the cylindrical 

quartz ampoule containing the Pb-5.8Sb alloy sample above from the heat extracting 

gallium bath below.  The cylindrical quartz ampoule containing the sample is vacuum 

sealed at the bottom and is evacuated from the top by using a diffusion vacuum pump, 

giving typically ~10 millitorr of dynamic vacuum. Figure 10(c) shows one of the quartz 

ampoules containing the Pb-Sb sample used in this research. Ten fine tipped chromel-

allumel thermocouples are attached to the ampoule outer surface at separation distances 

of 1 to 1.5 cm to record the temperature along the length of the sample as a function of 

time using a data-logging system. Location of the thermocouples is indicated in Figure 

10(c). A [100] oriented Pb-5.8Sb seed rod is kept at the bottom with additional remelt 

stock above. The furnace is slowly heated first to the set super heat temperature, it is held 

at that temperature for about 45-minutes, and then allowed to cool at a controlled cooling 

rate. As a result the feed bar above melts and fuses to the [100] oriented seed below 

before being re-solidified in a directional manner because of the heat being extracted 

from the bottom end. After several attempts optimum hot-zone temperature and cooling 

rates were established. With a hot-zone temperature of 650 C two samples were finally 
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directionally solidified at slow and fast cooling rates, 0.5 C/min and 4 C/min, as listed in 

Table-2 below. 

 

(a) 

 

(b) 
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(c) 

 

(d) 

Figure 9.  Gradient Freeze DS facility and process. (a) Gradient Zone DS facility (b) 

Detailed image of the heat extracting gallium bath at the bottom, (c) typical quartz 

crucible in this research showing the locations where chromel-alumel thermocouples 

were attached on its outer surface, (d) Locations of the thermocouple tips as a function of 

distance from the initial location of TE at the onset of DS.  

 

Sample ID Sample Dimension Cooling Speed 

Pb-Sb-12_11_17 Constant 9 mm  0.5 °C/min 

Pb-Sb-11_6_17 Constant 9 mm 4 °C/min 

Table 2 Growth conditions of two Pb–5.8 Sb samples examined in this study. 

 

 

1.3. Specimen preparation (transverse sections) and metallography 

The experimentally obtained thermal profile during the DS process (typically 

shown in Figure 12 for a sample cooled at 4 C/min) was used to obtain the initial location 

of the Eutectic Isotherm (TE) at the onset of directional solidification. Then transverse 

sections were cut along the sample length at 0.5, 1, and 1.5 cm distances with respect to 

the TE for further metallograohy and image analysis. Typical transverse section locations 

and their corresponding IDs were also shown in Figure 11 shown above.  
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Figure 10. Temperature profile recorded by ten thermocouples located at known 

separation distances as a function of processing time for a typical gradient-freeze DS at a 

4 C/min furnace cooling rate.   

 

1.3.1. Cutting, Mounting, And Polishing 

          A thin grove was machined all along the sample length of the Directional 

solidified sample prior to cutting transverse slices off so that transverse images taken at 

various distances can later on be aligned with respect to each other. A low-speed, variable 

RPM, precision wafer saw was used to cut the samples at various pre-determined 

locations by using diamond tipped low-grit precision saw blades having 0.3 mm 

thickness.  Once sliced, the “hot end” of each slice was marked by black ink for their 

further mounting. The cut slices were cold mounted. A cylindrical plastic mold was 

lubricated with industrial oil and the specimen was placed in the middle of the mold with 

the “hot side” facing downward. In a separate container, 30 mL of Struers Epofix resin 

was carefully mixed with 15 mL of Struers Epofix hardener to create an epoxy mixture. 

The epoxy mixture was then poured over the cylindrical mold and allowed to cure 

overnight.  



20 

 

A Leica SM2500E Ultramiller was then used to further prepare the surface of the 

mounted sample for subsequent polishing.The surface preparation procedure consisted of 

two steps: the initial machining using a pre-miller, followed by final machining using 

suitable diamond blades to obtain a mirror-like surface. Ethelyne glycol was used as a 

lubricant during ultramilling process. The adhered residue materials on the sample 

surface were then removed by using a water ultrasonic bath. A 9 mm Buehler Chemomet 

polishing cloth was used for final polishing step. Chemomet cloths are soft, porous, 

chemical-resistant, synthetic pad for softer materials which works well with the Pb-Sb 

surface. The polishing conditions used in this research are presented in Table 3. 

 

Average Grade (Grit) Force Time (min) Polishing Pad RPM 

9 mm Chemomet 21 lbs 7 110 

9 mm Chemomet 21 lbs 7 110 (opposite rotational direction) 

 

 

Table 3 Polishing procedure for 9-mm to 12.7-mm diameter sections sample preparation 

To eliminate contamination during polishing, 0.05 μm alumina slurry suspension 

was generously added on the surface of the polishing cloth. It is imperative to thoroughly 

clean the polishing cloth and specimens under running water after each round of 

polishing to eliminate alumina residue. Samples often need to be re-polished, solvated 

with ethyl alcohol, or cleaned in an ultrasonic bath to remove remaining colloidal 

alumina particles and oil. Avoid over-polishing as this can lead to wearing away of the 

softer alpha phase, creating an embossed surface with beveled edges on the final image 

that will be captured. Once finished, each sample was dried and then observed under the 

microscope for image capturing. 
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1.3.2. Optical Microscopy 

 A metallurgical brightfield inverted Nikon microscope with an attached 5.0-

megapixel digital camera utilizing SPOT 5.0 Image software was used to capture 

magnified images of the sample’s surface (50X). For such a large field of view, several 

overlapping images had to be taken by manually translating the microscope stage. A 12.7 

mm (1/2 in) diameter cross-sections sample typically required upwards of 90 images to 

cover the entire cross-section. The original digital images were saved with .TIF 

extensions for subsequent image-stitching using Photo Shop software. Parameters such as 

light exposure, gamma corrections, gain, and color-filters were manually selected to 

create best image quality and varied from sample-to-sample.  Ideal image quality was 

seen to possess constant light intensity across the whole field of view, for one phase and 

between samples and images.  High contrast light absorption differences between lead 

and antimony also aids in distinguishing phases that were present. It was important to 

clean and align the microscope’s projection lenses to capture consistent images. Typical 

settings include: 140 ms of exposure, a 1.00 gain factor, gamma correction of 0.50, and a 

green-tint light filter. For each sample, a known 1-mm scale was imaged to record pixel 

to millimeter ratio for images. But, oxide layers were known to grow rapidly on the 

metal’s surface if samples were stored for later microscopy. This is often avoided to 

eliminate unevenness in the overall quality of the image. 

1.3.3. Montage Making and Image Analysis 

      Adobe Photoshop CS5.1 on 64-bit Windows 7 on an HP z210 workstation was 

used for image stitching and montage making to obtain the high resolution image of the 

entire sample cross-section for subsequent morphological analysis. Image stitching is the 
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process of multiple photographic images with overlapping fields of view to produce a 

segmented high-resolution image. To adjust distortions, transformations for microscopic 

images are not required. Image stitching is simplifying the “Image registration” of 

locations or the process of transforming different sets of data into one coordinate system. 

Difficulties in conducting image stitching stems from intensity differences between 

images, intensity gradient in an image and partial unfocused features.  Averaging 

intensities and colors can blend two images to hide seams. Larger digital files are more 

difficult to stitch because they require more computing capabilities. For the larger cross-

section area slices like 120, image stitch required 10-14 hours of computing time and 

often lead to computer ‘freeze’. For smaller cross-sectional area like 10-20, smaller 

image collection needs 10-15 minutes to stitch.  

The montaged images were then suitably rotated using the surface grove 

machined along the sample length, such that the grove in each of the image was located 

at 90 deg.  

ImageJ v. 1.46 was used to measure primary dendrite trunk diameter. ImageJ is an 

open source National Institute of Health image analysis program that can be downloaded 

from http://rsb.info.nih.gov/ij/ for a variety of operating systems. Drawing a line between 

two pixels with (x,y) coordinates can calculate length 𝑑 =  √𝑥2 + 𝑦2. Appropriate 

measurement values must be selected prior to drawing line segments. This is done by 

choosing Analyze > Set Measurements >Bounding rectangle > OK, which measures a 

rectangle bounded by the two end points of the line segment acting as a diagonal. After 

choosing the line-selection tool and making a line-selection on an image, choosing 

Analyze > Measure will print a set of numbers for a ‘Bounding rectangle.’ 
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A bounding rectangle has 6 measurements labeled BX, BY, Width, Height, 

Angle, and Length. A rectangle can be drawn with the extreme values of x and y for the 

four corners of the rectangle provided a line segment with two sets of (x,y) coordinates. 

The line drawn is arbitrarily set as one of the diagonals. ‘BX’ and ‘BY’ are the upper-left 

x and y coordinate in pixels in relation to the upper-left corner of an image, ‘Width’ and 

‘Height’ are the width and height of the bounding rectangle, ‘Angle’ is the minimum 

angle between the drawn line and an imaginary line facing due right from the ‘starting’ 

point for the drawn line, and ‘Length’ is the length of the drawn line.  

1.3.4. Dendrite Trunk Diameter 

For the dendrite trunk diameter measurement, two lines are drawn such that each 

line is a minimum distance spanning the trunk, as shown in Figure 12. For an ideal well-

formed dendrite, these two lines will be perpendicular to each other. The diameter of that 

trunk was taken as the average of those two lines lengths in pixels. Dendrite center was 

also calculated from these measurements by knowing the intersection of these two lines. 

This calculation was done through a computer program written in VBA coding language 

for Excel 2010, listed in the appendix. Though dendrite center absolute (x,y) coordinates 

are irrelevant, coordinates are important for spacing calculations which will be discussed 

in the later sections. 
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Figure 11.  Screen capture of bounding rectangle measurement for trunk diameter 

 

1.3.5. Primary Dendrite Spacing 

1.3.5.1. Nearest Neighbor Spacing 

 Numerical analysis using dendrite center (x,y) coordinates measured in ImageJ 

allows for the calculation of nearest neighbor spacing. The minimum of the set of all 

possible distances were calculated with a caveat that the set of all possible distances will 

not contain duplicates through the symmetric property of equality.  Given a set of (x,y) 

coordinates, a VBA macro code for Excel 2010 was written to calculate nearest neighbor 

spacing.  
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1.3.5.2. Minimum Spanning Tree 

              A minimum spanning tree is obtained by connecting all the center of mass 

values which are obtained from the image analysis (Typically shown in Figure13). It 

represents the shortest total distance by connecting all the nodes, without having any 

closed loop. The center which is nearest to the other dendrite is located and joined to 

form network and this process is repeated until all the centers of dendrites are connected 

to the minimum spanning tree. Mean and standard deviation values of the branch lengths 

are also used as representing the primary dendrite spacing.  

.  

12.  Minimum Spanning Tree for a directionally solidified Pb-5.8 Sb alloy 

microstructure. 

1.3.6. Fraction Eutectic 

1.3.6.1. Thresholding 

The composition at a location can be calculated if the fraction eutectic is known. 

Fraction eutectic can be calculated using the area covered by the eutectic region divided 

by the total area of the sample. The difference in color intensities of the lead-rich and 
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antimony-rich region based on their light absorption allows for identification of distinct 

structures from captured images. High intensity lead-rich α phase can then be separated 

from the antimony-rich eutectic. Thresholding allows for the separation of pixels based 

on intensity values (Figure 14). For 8-bit image pixels are labeled between 0 and 255 

based on intensity where black is assigned a value of 0 and white is 255. A number is 

chosen where all numbers equaling that value or higher will be given a value of 255 and 

all lower a value of 0. Thresholding transforms an 8-bit grayscale image into a binary 

image of black and white pixels. Picking a proper cut-off intensity value is vital for 

accuracy to ensure user bias is not introduced as image intensity vary from sample to 

sample. ImageJ has a built-in thresholding algorithm under “default” which was used for 

thresholding.  

A “Region of Interest” must always be selected before thresholding to eliminate 

unwanted background pixels that will not be included in the later calculation. In the 

ImageJ menu select: Edit > Selection > “Create Selection.” To execute the algorithm, 

select: Image > Adjust > “Threshold.” The image can be inverted so that the dendrite 

phase is black, and the antimony-rich phase is white. In the case where the values for 

black and white are inverted select: Image > Lookup Tables > “Invert LUT”. Hover over 

the black and white regions to ensure that the assigned values correspond to the correct 

color.  
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Figure 13. Typical example depicting the thresholding procedure of an 8-bit image of an 

Pb-Sb transverse slice with corresponding intensity histograms. 

1.3.6.2. Watershed 

The eutectic phase is composed of both antimony-rich (white region) and lead-

rich phase (black regions within eutectic). Since not all black pixels can be considered a 

fraction of the dendrites as seen from Figure 15, the lead-rich metastable phases 

remaining within the eutectic which are colored similarly to the α phase should be 

separated and eliminated prior to fraction eutectic calculation. A watershed algorithm was 

used to accomplish this. 

A watershed transformation draws 1-pixel wide white pixels through geographical 

minimum distances between regions of white. The binary image of antimony-rich white 

particles embedded into lead-rich black landscape are connected by a spider web of lines, 

sectioning the lead-rich black landscape into particles. It should be noted that the drawn 

white pixels add to the white count and subtract from the black count by 0.5 - 1% of the 

total pixel count (which can be calculated by [black particle count before watershed] - 

[black particle count after watershed]). 
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Figure 14.  Typical example depicting the watershed and particle area cut-off procedure 

of a binary image.  

1.3.6.3. Particle Size Cut-Off 

After water shedding the image, individual particles are created from the 

previously connected lead-rich black regions within the eutectic. To eliminate eutectic α 

phase from being included in the calculation of primary dendrite α phase, particles having 

areas smaller than a specified pixel area cutoff value were ignored while measuring the 

area fraction occupied by primary dendrites. Pixel area cutoff value ranges from 1000-

2500 pixels and may vary from image to image. Different cutoff values will affect results 

by 1-2% for 100% increase or decrease in area cut-off. Once this value is determined, the 

eutectic α phase particles can be selected as a “Region of Interest” and are then filled 

with white to eliminate its fraction contribution.   

1.3.6.4. Fraction Eutectic Calculation 

Fraction eutectic can be calculated once the eutectic black particles (eutectic α) 

are eliminated and a binary image has been created. Given a ‘Region of Interest’, the 

mean intensity value can be calculated. Particle’s values are 255 for white or 0 for black. 
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Therefore, [mean intensity]/255 = [fraction alpha] and 1-[fraction dendrite] = [fraction 

eutectic]. As this process is standard from image to image, a macro was written for 

ImageJ to process a batch of images. 
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CHAPTER IV 

RESULTS AND DISCUSSION 

4.1. Dendrite Morphology Variations During Gradient Freeze DS 

Transverse views along the directionally solidified length for the two samples 

examined in this research 12_11_17 and 11_6_17 with cooling zone 0.5°C and 4°C are 

presented below in Figures 16, 17, 18 and 19 below.  The corresponding ID and distance 

with respect to the TE at the onset of DS for each section are listed in the figures.  

4.1.1. Gradient Freeze DS at Slow Cooling Rate 

        Figure 16 shows the transverse microstructures obtained from sample 

#12_11_17 which was solidified at 0.5 C/min cooling rate.  Figure 17 shows higher 

magnification views from these sections. The dark interdendritic eutectic regions separate 

the primary dendrites. The morphology is initially cellular having no branches (Fig. 16 

(b), (c), 17 (b), (c). It shows cell to dendrite transition at approximately 2.75 cm (Fig. 16 

(d) and Fig. 17 (d)) and formation of side-arms beginning at approximately 4.75 cm (Fig. 

16 (f) and Fig 17 (f)). Well-branched dendrite arrays are obtained at a distance of about 

5.75 cm (Fig. 16 (g) and Fig 17 (g).  These microstructures also suggest that the area 

fraction occupied by the eutectic portion is increasing as a function of solidification 

distance, 
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indicating a longitudinal segregation of Sb. This growth condition is susceptible to 

severe plume convection as seen by the channel segregates present on several transverse 

sections, especially during initial DS process. 

    

                     (a)                                                   (b)                                                    (c) 

      

                    (d)                                                    (e)                                                    (f) 

         

                    (g)                                                     (h)                                                    (i) 
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                   (j)                                                    (k)                                                    (l) 

       

                 (m)                                                      (n)                                

15.  Transverse microstructure of 12_11_17 at different distance away from Te (a) 0.25 

cm (b) 0.75 cm (c) 1.75 cm (d) 2.75 cm (e) 3.75 cm (f) 4.75 cm (g) 5.75 cm (h) 6.75 cm 

(i) 7.75 cm (j) 8.75 cm (k) 9.75 cm (l) 10.75 cm (m) 11.75 cm (n) 12.75 cm (o) 13.75 cm 

           
                     (a)                                                          (b)                                                               (c) 

               
                      (d)                                                          (e)                                                               (f) 
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                       (g)                                                          (h)                                                               (i) 

        
                         (j)                                                          (k)                                                               (l) 

       
                     (m)                                                          (n)                                                               

Figure 16.  Transverse microstructure of 12_11_17 at different distance away from Te (a) 

0.25 cm (b) 0.75 cm (c) 1.75 cm (d) 2.75 cm (e) 3.75 cm (f) 4.75 cm (g) 5.75 cm (h) 6.75 

cm (i) 7.75 cm (j) 8.75 cm (k) 9.75 cm (l) 10.75 cm (m) 11.75 cm (n) 12.75 cm (o) 13.75 

cm 

 

4.1.2. Gradient Freeze DS at Fast Cooling Rate 

Figure 18 shows the transverse microstructures obtained from sample #11_6_17 

which was solidified at 4 C/min cooling rate.  Figure 19 shows higher magnification 

views from these sections. The morphology is initially cellular having no branches (Fig. 
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18(a), 19(a). It shows cell to dendrite transition at approximately 1 cm (Fig. 18(b) and 

Fig. 19(b)) and formation of side-arms begins at approximately 3 cm (Fig. 18(d) and Fig 

19(d)). Well-branched dendrite arrays are obtained at a distance of about 7 cm (Fig. 18 

(h) and Fig 19 (h).  In this sample also, the area fraction occupied by the eutectic portion 

appears to increase as a function of solidification distance. However, at this speed no 

visible presence of channel segregate is seen along the entire DS length of the sample.  

                  
                     (a)                                                          (b)                                                          (c) 

                     
                     (d)                                                          (e)                                                          (f)  

                        
                     (g)                                                          (h)                                                           (i) 
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                     (j)                                                          (k)                                                          (l) 

 

 
                       (m)    

Figure 17.  Transverse microstructure of 11_6_17 at different distance away from Te (a) 

0.5 cm (b) 1 cm (c) 2 cm (d) 3 cm (e) 4 cm (f) 5 cm (g) 6 cm (h) 7 cm (i) 8 cm (j) 9 cm 

(k) 10 cm (l) 11 cm (m) 12 cm 

              

                       (a)                                                          (b)                                                               (c) 

            

                     (d)                                                          (e)                                                               (f) 
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                     (g)                                                          (h)                                                               (i) 

                  

                     (j)                                                          (k)                                                               (l) 

 

                     (m)    

Figure 18.  Transverse microstructure of 11_6_17 at different distance away from Te (a) 

0.5 cm (b) 1 cm (c) 1 cm (d) 3 cm (e) 4 cm (f) 5 cm (g) 6 cm (h) 7 cm (i) 8 cm (j) 9 cm 

(k) 10 cm (l) 11 cm (m) 12 cm 

 Actual distance from TE end, (cm) 

(12_11_17) (11_6_17) 

Primary cell structure 2.75 1 

Cell to dendrite structure transformation 4.75 3 

Well branched dendrite structure 5.75 4 

Table 4 Comparison of dendrite morphology variation with respect to distance for slower 

and faster cooling rate sample 

 



37 

 

Table 4 shows that development of dendrite morphology with respect to distance 

for both slower and faster cooling rate sample. According to the cell structure appears in 

both cooling rate samples, it appears is much earlier in faster cooling rate than slower 

cooling rate sample. The same thing is observed where transformation of cell to dendrite 

structure is appeared and where well branched dendrite structure is observed. Due to 

faster cooling rate in sample 11_6_17, development of dendrite morphology is much 

faster than slower cooling rate sample 12_11_17. 

4.2. Thermal Gradient and Growth Speed Variation Along DS length 

        The procedure by which the thermal gradient and growth speed corresponding to 

the transverse sample locations along the length of the directionally solidified samples 

were measured for a comparison of primary dendrite spacing and trunk diameters is 

described below.  The thermal profile recorded by the ten thermocouples as a function of 

time during the furnace cooling period were used to identify the relative distance the of 

eutectic isotherm (dL) and the liquidus isotherm (dE) (with respect to their initial locations 

at the onset of DS process) as a function of time as the mushy-zone traversed from one 

end of the sample to the other. These plots can be used to extract the growth speed (cm s
-

1
) and the mushy zone freezing rate (K s

-1
) as a function of solidification distance. The 

value of the thermal gradient (K cm
-1

), can then be determined, because freezing rate= 

growth speed * thermal gradient. However, because the thermocouple locations are 

different from the locations where transverse sections were made (typically shown in 

Figure 11(d)), first 4
th

 degree polynomial fit was made to the eutectic and liquidus 

isotherm traverse distance versus time data, and then the polynomial parameters were 

used to back calculate the time at which the eutectic and liquidus isotherms arrived at the 



38 

 

locations where transverse microstructures have been examined. Results are presented 

below.  

4.2.1. High Cooling Rate Sample (sample ID: 11_6_17) 

                        Sample #11_6_17 was solidified at 4°C/min from the furnace temperature 

of 650 C.  Figure 20 shows the temperature profiles recorded by the ten thermocouples 

with respect to time for this sample. Figure 21 shows a portion extracted from Figure 20 

where the temperature profiles are limited to mushy zone freezing rage from 290 C (TL= 

288 C) to 250 C (TE=252 C).  Figure 22 plots the distance of the eutectic and liquidus 

isotherms with respect to TE at the onset of DS for # 11_6_17. Circles correspond to the 

thermocouple locations and * correspond to the locations of transverse section. If 

thermocouple measure profiles (circles) is tried to fit with 3
rd

 degree polynomial, residual 

value is 542.63. If it tried to fit with 4
th

 degree polynomial, residual value is 308.803 and 

if it fit with 5
th

 degree polynomial, residual value is 308.802.  Then ideal value of residual 

is obtaining by 4
th

 degree polynomial line and lines are the 4
th

 degree polynomial fit to 

the thermocouple measured profiles (circles). Table 5. Lists the ID of all the transverse 

sections, their locations with respect to that of TE at the onset of DS, and the times when 

the eutectic and liquidus isotherms arrived at those locations (extracted from Figure 22) 

for high cooling rate  gradient freeze DS (# 11_6_17). 
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Figure 19. Temperature along the sample length with respect to time for # 11_6_17 

sample. 

 

Figure 20. Temperature variation from 290 C (   C above the liquidus) to 250 C (  C 

below the eutectic) as a function of time for sample # 11_6_17 
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Figure 21. Distance of eutectic and liquidus isotherms with respect to TE at the onset of 

DS for # 11_6_17. Circles correspond to the thermocouple locations and * correspond to 

the locations of transverse section. The lines are the 4
th

 degree polynomial fit to the 

thermocouple measured profiles. 

Sample ID 

(11_6_17) 

Distance 

from Te 

(cm) 

Time when 

TL at sample 

(s) 

Time when 

TE at sample 

(s) 

1B 0.5 491.058654 1658.118503 

1 1 1498.01278 2546.609949 

2 2 3015.578532 3888.803872 

3 3 4010.957848 4774.291667 

4 4 4631.159676 5332.438351 

5 5 4999.746882 5671.751824 

6 6 5216.836247 5879.882867 

7 7 5359.098466 6023.625144 

8 8 5479.758149 6148.915199 

9 9 5608.593823 6280.832459 

10 10 5751.937929 6423.599233 

11 11 5892.676823 6560.580711 

12 12 5990.250777 6654.284965 

Table 5 Locations of transverse samples and the times when the eutectic and liquidus 

isotherms arrived at those locations (# 11_6_17). 
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Using data presented in Table 5, the mushy-zone freezing time corresponding to 

the transverse sample locations were extracted and are plotted in Figure 23.  The 

corresponding mushy-zone cooling rates were then calculated,   

𝑀𝑢𝑠ℎ𝑦 𝑧𝑜𝑛𝑒 𝑐𝑜𝑜𝑙𝑖𝑛𝑔 𝑟𝑎𝑡𝑒(𝐾/𝑆) = {
( (𝑇𝐿) − (𝑇𝐸)

𝐹𝑟𝑒𝑒𝑧𝑖𝑛𝑔 𝑇𝑖𝑚𝑒 
} 

These are presented in Table 6 and are plotted in Figure 24.  

 

Figrue 22. Mushy-zone freezing time verses distance for transverse sample locations 

(#11_6_17) 

 

Figure 23. Mushy zone freezing rate with respect to distances of transverse samples 

(#11_6_17) 
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 Sample ID 

(11_6_17) 

Distance from TE 

(cm) 

Mushy zone freezing rate 

(K/s) 

1B 0.5 0.04798383 

1 1 0.05340468 

2 2 0.06413007 

3 3 0.0733624 

4 4 0.07985413 

5 5 0.08333272 

6 6 0.08445862 

7 7 0.08427051 

8 8 0.08368738 

9 9 0.08330375 

10 10 0.08337536 

11 11 0.0838444 

12 12 0.08433301 

Table 6  Mushy zone freezing rate with respect to distance for transverse samples cut 

from #11_6_17  

            The growth speed of the liquidus and eutectic isotherms corresponding to the 

locations of the transverse sections were obtained by calculating the slopes of the 

distance vs time plots (calculated from their corresponding polynomial fits (Figure 22)). 

These growth speeds are presented in Table 7 and are plotted in Figure 25.  The mean of 

these two speeds has been used in comparing the experimentally observed and 

theoretically predicted values of the primary spacing and trunk diameter later.  
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Sample ID 

(11_6_17) 

Distance from TE 

(cm) 

Growth speed at 

liquidus (cm/s) 

Growth speed at 

Eutectic (cm/s) 

Mean growth speed 

(cm/s) 

1B 0.5 0.000454106 0.000514935 0.000485 

1 1 0.000545398 0.00061771 0.000582 

2 2 0.000812997 0.000916975 0.000865 

3 3 0.001273491 0.001424513 0.001349 

4 4 0.002101924 0.002312762 0.002207 

5 5 0.003595751 0.003833593 0.003715 

6 6 0.005922375 0.006004474 0.005963 

7 7 0.008029289 0.007776161 0.007903 

8 8 0.008214333 0.007926327 0.00807 

9 9 0.007299892 0.007226666 0.007263 

10 10 0.00680978 0.006925942 0.006868 

11 11 0.007820429 0.008108353 0.007964 

12 12 0.017664707 0.018397892 0.018031 

Table 7 Growth speed of the eutectic and liquidus isotherms vs. distance of the cross-

sections with respect to TE at the onset of DS for #11_6_17 

 

Figure 24.  Growth speed with respect to distances of transverse samples (#11_6_17) 
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The mushy zone freezing rates presented in Table 6 (Figure 24) were used 

together with the eutectic and liquidus isotherm speed data from Table 7 (Figure 25) to 

calculate the thermal gradients corresponding to the transverse sample location at the 

eutectic and liquidus temperatures in the manner described earlier.   

𝑅 (
𝑐𝑚

𝑠
) ∗ 𝐺 (

𝐾

𝑐𝑚
) = 𝑀𝑢𝑠ℎ𝑦 𝑧𝑜𝑛𝑒 𝑐𝑜𝑜𝑙𝑖𝑛𝑔 𝑟𝑎𝑡𝑒 (

𝐾

𝑠
) 

R = Mean growth rate of liquidus and eutectic, G = Thermal gradient at liquidus or at 

eutectic, as needed. 

Sample ID 

(11_6_17) 

Distance from TE 

(cm) 

Thermal gradient at liquidus 

(K/cm) 

Thermal gradient at eutectic 

(K/cm) 

1B 0.5 105.6665334 93.18430207 

1 1 97.91874098 86.45593106 

2 2 78.88108621 69.93652755 

3 3 57.60730426 51.50000015 

4 4 37.99096648 34.52761091 

5 5 23.17532924 21.73749748 

6 6 14.26093724 14.06594706 

7 7 10.49538793 10.83703282 

8 8 10.1879703 10.55815432 

9 9 11.41164119 11.52727252 

10 10 12.24347204 12.03812463 

11 11 10.72120167 10.34049733 

12 12 4.774096055 4.583840776 

Table 8 Values of Thermal gradient with respect to distances of transverse samples 

(#11_6_17). 
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                   Table 8 gives the calculated values of thermal gradient at each location for 

liquidus and eutectic. By plotting values of Table 8 thermal gradient plot with respect to 

distance of sample gives the thermal profile of higher cooling rate sample 11_6_17 

 

Figure 25.  The liquidus and eutectic thermal gradients with respect to distances of 

transverse samples (#11_6_17). 

4.2.2. Slow Cooling Rate Sample (sample ID: 12_11_17) 

  Sample #12_11_17 was solidified at 0.5°C/min from the furnace temperature of 

650°C, which is slower cooling rate sample. Figure 27 shows the temperature recorded 

by the ten different thermocouples with respect to time for this sample. Mushy zone 

freezing range is from 290 C (TL= 288 C) liquidus to 250 C (TE=252 C) eutectic and 

Figure 28 shows a portion extracted from Figure 28 where temperature profile is limited 

to mushy zone range. Figure 29 plots the distance of the eutectic and liquidus isotherms 

with respect to TE at the onset of DS for 12_11_17. Circles correspond to the 

thermocouple locations and * correspond to the locations of transverse section. If 

thermocouple measure profiles (circles) is tried to fit with 3
rd

 degree polynomial, residual 

value is 4171.02. If it tried to fit with 4
th

 degree polynomial, residual value is 2137.66 
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and if it fit with 5
th

 degree polynomial, residual value is 683.58.  Then ideal value of 

residual is obtaining by 4
th

 degree polynomial line and lines are the 4
th

 degree polynomial 

fit to the thermocouple measured profiles (circles). Table 4. Lists the ID of all the 

transverse sections, their locations with respect to that of TE at the onset of DS, and the 

times when the eutectic and liquidus isotherms arrived at those locations (extracted from 

Figure 29) for slow cooling rate  gradient freeze DS (12_11_17).                                      

  
Firgrue 26.  Temperature along the sample length with respect to time for #12_11_17 

sample  

                      

Figrue 27.  Temperature variation from 290 C (   C above the liquidus) to 250 C (  C 

below the eutectic) as a function of time for sample #12_11_17 
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Figure 28.  Distance of eutectic and liquidus isotherms with respect to TE at the onset of 

DS for #12_11_17. Circles correspond to the thermocouple locations and * correspond to 

the locations of transverse section. The lines are the 4
th

 degree polynomial fit to the 

thermocouple measured profiles. 

                
Sample ID 

(12_11_17) 

Distance 

from TE 

(cm) 

Time when 

TL at sample 

(s) 

Time when 

TE at sample 

(s) 

1B 0.25 -6.07E+03 2.32E+03 

1 0.75 2.51E+03 1.05E+04 

2 1.75 1.53E+04 2.24E+04 

3 2.75 2.34E+04 2.99E+04 

4 3.75 2.84E+04 3.42E+04 

5 4.75 3.12E+04 3.65E+04 

6 5.75 3.28E+04 3.77E+04 

7 6.75 3.38E+04 3.84E+04 

8 7.75 3.48E+04 3.91E+04 

9 8.75 3.60E+04 4.02E+04 

10 9.75 3.74E+04 4.15E+04 

11 10.75 3.89E+04 4.31E+04 

12 11.75 4.01E+04 4.43E+04 

13 12.75 4.03E+04 4.47E+04 

14 13.75 3.88E+04 4.34E+04 

Table 9 Locations of transverse samples and the times when the eutectic and liquidus 

isotherms arrived at those locations (#12_11_17). 
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Using data presented in Table 9, the mushy-zone freezing time corresponding to 

the transverse sample locations were extracted and are plotted in Figure 30.  As discussed 

earlier, using the data points of freezing time and mushy zone temperature difference 

corresponding mushy zone cooling rate were calculated which tabulated in Table 10 and 

plotted in Figure 31. 

 

Figure 29.   Mushy-zone freezing time verses distance for transverse sample locations 

(#12_11_17) 
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Figure 30. Mushy zone cooling rate with respect to distance for 12_11_17  

 

Sample ID 

(12_11_17) 

Distance from TE 

(cm) 

Mushy zone cooling rate 

(K/s) 

1B 0.25 0.0067 

1 0.75 0.007 

2 1.75 0.0078 

3 2.75 0.0087 

4 3.75 0.0096 

5 4.75 0.0105 

6 5.75 0.0115 

7 6.75 0.0123 

8 7.75 0.013 

9 8.75 0.0134 

10 9.75 0.0137 

11 10.75 0.0136 

12 11.75 0.0133 

13 12.75 0.0127 

14 13.75 0.012 

Table 10 Values of Mushy zone cooling rate with respect to distance for 12_11_17 
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The growth speed of the liquidus and eutectic isotherms corresponding to the locations of 

the transverse sections were obtained by calculating the slopes of the distance vs time 

plots (calculated from their corresponding polynomial fits (Figure 31)). These growth 

speeds are presented in Table-11 and are plotted in Figure 32.  The mean of these two 

speeds has been used in comparing the experimentally observed and theoretically 

predicted values of the primary spacing and trunk diameter later.  

Sample ID 

(12_11_17) 

Distance from TE 

(cm) 

Growth speed at 

liquidus (cm/s) 

Growth speed at 

Eutectic (cm/s) 

Mean growth speed 

(cm/s) 

1B 0.25 5.31E-05 5.58E-05 5.44385E-05 

1 0.75 6.43E-05 6.80E-05 6.61425E-05 

2 1.75 9.78E-05 1.06E-04 0.000101656 

3 2.75 1.58E-04 1.76E-04 0.00016664 

4 3.75 2.70E-04 3.19E-04 0.000294745 

5 4.75 4.85E-04 6.28E-04 0.000556755 

6 5.75 8.19E-04 0.0012 0.00100948 

7 6.75 0.001 0.0015 0.00125 

8 7.75 9.35E-04 0.0011 0.00101758 

9 8.75 7.55E-04 8.23E-04 0.000788935 

10 9.75 6.62E-04 6.72E-04 0.000667175 

11 10.75 7.08E-04 6.79E-04 0.000693615 

12 11.75 0.0012 0.001 0.0011 

13 12.75 -0.002 -0.0035 -0.00275 

14 13.75 -3.63E-04 -4.06E-04 -0.0003848 

Table 11 Growth speed of the eutectic and liquidus isotherms vs. distance of the cross-

sections with respect to TE at the onset of DS for #12_11_17 
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Figure 31.  Growth speed with respect to distance of sample (#12_11_17) 

The mushy zone freezing rates presented in Table-10 (Figure 31) were used 

together with the eutectic and liquidus isotherm speed data from Table 11 (Figure 32) to 

calculate the thermal gradients corresponding to the transverse sample location at the 

eutectic and liquidus temperatures in the manner described earlier.   

Table 12 gives the calculated values of thermal gradient at each location for 

liquidus and eutectic. By plotting values of Table 12 thermal gradient plot with respect to 

distance of sample gives the thermal profile of higher cooling rate sample 12_11_17. 
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Sample ID 

(12_11_17) 

Distance from TE 

(cm) 

Thermal gradient at liquidus            

(K/cm) 

Thermal gradient at liquidus           

(K/cm) 

1B 0.25 125.6996 119.6594 

1 0.75 109.5921 103.5682 

2 1.75 80.1859 74.2564 

3 2.75 55.2323 49.4984 

4 3.75 35.5414 30.1292 

5 4.75 21.7293 16.7879 

6 5.75 13.9888 9.6842 

7 6.75 11.8292 8.3312 

8 7.75 13.8678 11.3309 

9 8.75 17.7984 16.3391 

10 9.75 20.634 20.3104 

11 10.75 19.2134 20.0139 

12 11.75 10.8087 12.6543 

13 12.75 -6.4012 -3.6423 

14 13.75 -33.1549 -29.6452 

Table 12 Values of Thermal gradient with respect to distance for 12_11_17 

 

Figure 32.  Thermal gradient verses Distance on sample 12_11_17  
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4.3. Dependence of the solidification behavior as a function of furnace cooling 

rate during gradient freeze DS process.  

       Figure 34 compares the mushy-zone freezing time of the two Pb-5.8 Sb samples 

Directional solidified at two furnace cooling rates, 4 K/min (11_6_17) and at 0.5 K/min 

(12_11_17).  For both samples the freezing time decreases as the liquid solid interface 

moves from the bottom end of the melt column towards its top end, because the heat is 

being extracted only from the bottom end which is maintained at room temperature by the 

gallium bath. As the length of the solidified portion of the alloy increases it provides 

additional resistance to the heat transfer at the cold end and the actual thermal gradient in 

the mushy-zone up above decreases. The heat is also being extracted from the hot end of 

the sample because radially (as shown schematically in Figure 35). It becomes rate 

controlling towards the end of the DS as compared with the little heat still being extracted 

from the bottom. The melt still left to solidify begins to undercool and solidify in a non-

directional manner.  

If the furnace cooling rates were actually felt throughout the length of the actual 

sample during directional solidification then one would have expected a mushy-zone 

freezing time of 540 and 4320 S for the two Pb-5.8Sb alloy samples #11_6_17 and 

12_11_17, respectively. Figure 34 shows those actual freezing times are much larger than 

that especially in the beginning of DS.  Only after about 6 cm after onset of DS till about 

11 cm of DS a reasonably constant freezing rate is being maintained and one can assume 

a steady state growth condition. During the initial 6-cm of DS the growth conditions are 

transient. This is also reflected in the thermal gradient and growth speed variation plots 

shown in Figure 36 and 37.  Therefore comparison of dendrite morphology with 
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predictions from theoretical models would make sense only for transverse sections from 

about 6 cm to 11 cm distances.  

 
(a) 

 
(b) 

Figure 33.  Effect of furnace cooling rate on the mushy-zone freezing time at transverse 

sections located at increasing distance from TE at the onset of DS. (a) #11_6_17, (4 

°C/min) (b) # 12_11_17, (0.5°C /min). 
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Figure 34.  Heat extraction from the top of the ampoule region becomes more dominant 

as compared with that from the bottom cold end of the sample as liquid-soli interface 

moves towards the top and the liquid left is at relatively low temperatures.  

 

                           (a)                                                                              (b) 

Figure 35.  Effect of furnace cooling rate on the eutectic and liquidus isotherm speeds as 

a function of distance from TE at the onset of DS (a) #11_6_17 (4 C/min) (b) # 12_11_17   

(0.5 C/min). 
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                              (a)                                                                              (b) 

Figure 36.  Effect of furnace cooling rate on the eutectic and liquidus isotherm thermal 

gradient as a function of distance from TE at the onset of DS (a) #11_6_17 (4 C/min) (b) 

# 12_11_17   (0.5 C/min). 

4.4. Macrosegregation along the DS length  

  Figure 38 plots the fraction eutectic with respect to solidification distance for the two 

samples, one cooled at 0.5 C/min and the other at 4 C/min. The fraction eutectic increases 

with increasing solidification distance implying that the melt column poor in the solute 

continuously gets richer in antimony content. 

 

Figure 37.  Fraction eutectic verses distance from eutectic 
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The fraction eutectic values were used in the following relationship to obtain the 

mean solid composition on each transverse section (Cs): 

CS = {-3.5109 * (fS)
2
 + 13.4846 * (fS) + 0.801862} 

Here, fs is the fraction volume solidified. Since the alloy melt composition (Co) was 

5.8 % Sb, which is also the mean of Cs across the entire sample length the Cs values 

calculated from the above relationship were back calibrated, and the ratio Cs/Co is 

plotted as a function of fraction solidified in Figure 39.  This macrosegregtaion is caused 

by the “plume” type of thremosolutal convection which makes the solute rich melt from 

the bottom of the mushy-zone to move towards the array tips where it mixes with rest of 

the bulk melt above. This results in a continuous solute enrichment along the DS length. 

In the absence of such convection the Cs/Co value would be expected to remain unity 

along the DS length. 

 

Figure 38. Longitudinal macrosegregation (Cs/Co) as a function of fraction solidified (fs) 
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      Such macrosegregation has been shown to follow a CS/C0 = ke (1-fe
)
 k

e-1
 relationship 

[10] where ke is termed as effective partition coefficient. The effective partition 

coefficient can be obtained from the intercept and the slope of a log(Cs/Co) vs log (1-fs) 

plot after a linear regression fit to the experimental data. The ke value increases with 

increasing intensity of thermosloutal convection. Figure 40 shows the linear regression fit 

for the log(Cs/Co) vs log (1-fs) data for the two samples examined in this study. Average 

ke values obtained from the slope and that from the intercept for #11_6_17 is 0.6374 and 

for the slower cooled sample #12-11-17 it is 0.7757. There is large scatter in the data, 

therefore, it is not possible to make definite conclusion, but the mictostructural 

observations (presence of “channel segregates in the slow cooled sample, vs their absence 

in the faster cooled sample) does suggest that there is more intense convection in the 

slower cooled sample. 
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Figure 39.  log (Cs/Co)  vs. log (1-fs) 
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4.5. Comparison with Theoretical Predictions 

4.5.1. Minimum Spanning Tree Spacing 

       Figure shows the minimum spanning trees obtained on the various cross 

sections of the two samples examined in this study. 

            

    .               (a)                                             (b)                                               (c) 

         

                    (d)                                             (e)                                             (f) 

      

                   (g)                                            (h)                                              (i) 
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                    (j)                                                 (k)                                               

Figure 40. Minimum spanning tree for #11_6_17 at various location from heat extraction 

end (a) 1 cm (b) 2 cm (c) 3 cm (d) 4 cm (e) 5 cm (f) 6 cm (g) 7 cm (h) 8 cm (i) 9 cm (j) 

10 cm (k) 11 cm   

                  
    .               (a)                                             (b)                                             (c) 

            
                    (d)                                          (e)                                                 (f) 

         
                   (g)                                              (h)                                              (i) 
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                  (j)                                              (k)                                                 (l) 

 
                   (m)                                                   

Figure 41. Minimum spanning tree for #12_11_17 at various location from heat 

extraction end (a) 1.75 cm (b) 2.75 cm (c) 3.75 cm (d) 4.75 cm (e) 5.75 cm (f) 6.75 cm 

(g) 7.75 cm (h) 8.75 cm (i) 9.75 cm (j) 10.75 cm (k) 11.75 cm (l) 12.75 cm (m) 13.75 cm  

 

Figure 40 shows the variation in Minimum Spanning Tree primary spacing with 

solidification distance for (a) 4 C/min cooling rate (sample #11_6_17) and (b) 0.5 C/min 

cooling rate (sample#12_11_17).  The symbols correspond to the mean MST spacing 

with one standard deviation. The dashed lines are primary spacings predicted for Hunt-Lu 

[18] model for dendrite morphology and the dotted lines are the Hunt-Lu prediction for 

cell morphology. The distances at which the cell to dendrite transition was observed are 

indicated by the red vertical line.  Both samples show an initial increase in the spacing as 

the morphology changes from cellular, to dendrites having only rudimentary side arms to 

well branched dendrites with increasing solidification distance. The cells have much 

smaller spacing as compared with dendrites, as expected from theoretical models [18]. 
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For dendritic morphologies the experimentally observed MST primary spacings are 

smaller than those predicted from the theoretical model which assumes only a pure 

diffusive transport environment during DS.  There is a larger deviation from theoretical 

predictions for dendrites formed in the slower cooling rate sample as compared with the 

faster cooling rate one.  

(a)

 

(b) 

Figure 42.  Variation in Minimum Spanning Tree primary spacing with solidification 

distance. (a) 4 C/min cooling rate (sample #11_6_17) and 0.5 C/min cooling rate 

(sample#12_11_17). The dashed line is primary spacing predicted for Hunt-Lu [18] 

model for dendrite morphology and the dotted line is Hunt-Lu prediction for cell 

morphology. The distance at which cell to dendrite transition was observed is indicated 

by the red vertical line.  
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4.5.2. Nearest Neighbor Spacing (NNS) 

Figure 41 shows the variation in nearest neighbor primary dendrite spacing as a 

function of increasing solidification distance for the (a) 4 C/min cooling rate (sample 

#11_6_17) and (b) 0.5 C/min cooling rate (sample#12_11_17).  The mean spacing and 

one standard deviation for the experimental measurements are plotted in these figures. 

The dashed lines are predicted values from the Hunt-Lu [18] model for dendrite 

morphology, and the dotted lines are prediction for the cell morphology. The vertical red 

lines show the distances at which the cell to dendrite transition was observed.  Both 

samples show an initial increase in the spacing as the morphology changes from cells, to 

dendrites having only rudimentary side arms to the well branched dendrites as liquid-

solid interface moves from the cold end to the hot end of the sample during gradient 

freeze DS process. The cells have much smaller spacing as compared with dendrites; this 

is expected from the theoretical models [18]. For dendritic morphologies the 

experimentally observed nearest neighbor spacings are, however, smaller than those 

predicted from the Hunt-Lu model.  The deviation from theoretical predictions is much 

larger in the slower cooling rate sample (Figure 41(b) vs. Figure 41(a)) as compared with 

the faster cooling rate one.  
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                                                                    (a) 

 

                                                                 (b) 

Figure 43.  Variation in nearest neighbor primary spacing with solidification distance. (a) 

4 C/min cooling rate (sample #11_6_17) and 0.5 C/min cooling rate (sample#12_11_17). 

The dashed line is Hunt-Lu [18] predictions for dendrite morphology and the dotted line 

is Hunt-Lu prediction for cell morphology. The distance at which cell to dendrite 

transition was observed is indicated by the red vertical line.  

          Figure 42 plots the ratio of the experimentally observed nearest neighbor spacing 

and that predicted from the Hunt-Lu model for “dendrite” morphology for the slow 
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cooled and fast cooled samples. The ratio expected would be unity if the gradient freeze 

DS had occurred under purely diffusive transport conditions. It ca be inferred from this 

figure that plume type thermo-solutal convection is responsible for the observed decrease 

in the primary dendrite spacing. The extent of decrease is much larger in the slower 

cooled sample because there was more intense convection in these samples as also 

indicated by the transverse microstructures described earlier.  

 

Figure 44.  Ratio of the experimentally observed nearest neighbor primary spacing to that 

predicted from Hunt-LU model for dendrite morphology during DS.   

4.5.3. Trunk Diameter (TD) 

Figure 43 shows the experimentally observed Primary Dendrite Trunk diameter as a 

function of solidification distance for the two cooling rate samples examined in this 

study, (a)  4 C/min cooling rate # 11_6_17, and (b) 0.5 C/min cooling rate 

#12_11_17.The mean and one standard deviation values are indicated by the data points.  

The dotted line is the trunk diameter predicted from the analytical model [19]. Since the 

model is valid only for the dendrite morphology and not for the cells, only the data to the 
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right of the cell-dendrite transition should be compared with the model predictions. The 

experimentally observed trunk diameters are larger than those predicted from theory. The 

difference again may be attributed to the thermosolutal convection present during 

gradient freeze DS of these Pb-5.8Sb alloy samples. 

 

(a) 

 

(b) 

Figure 45.  Variation in Primary Dendrite Trunk diameter as a function of solidification 

distance.  (a) 4 C/min cooling rate sample# 11_6_17 (b) 0.5 C/min cooling rate sample 

#12_11_17. The dotted line is the trunk diameter predicted from analytical model [19] 

which is strictly valid only for the dendrite morphology and not for the cells.
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CHAPTER V 

SUMMARY 

Directional solidification (DS) is the process of solidifying a metal alloy from one 

end to another resulting in aligned primary dendrites which are branched tree like 

features. Alignment of primary dendrites along [100] direction and their uniformity and 

distribution along the DS length determines the mechanical properties. These properties 

are especially important for single crystal turbine blade applications in modern gas 

turbine engines. Convection during solidification plays an important role in formation of 

detrimental defects, such as, misaligned grains, non-uniformity of dendrites and 

composition inhomogeneity.  Purpose of this study was to examine the microstructural 

evolution of primary dendrites during “Gradient Freeze DS process” in cylindrical Pb-

5.8% Sb alloy samples to generate the ground-based research data to support a future 

microgravity experiment on the Space Station in a convection free environment.  Pb-

5.8Sb was selected for this study because of its ease of processing and availability of 

physical property data which will be required for predicting the dendrite morphology 

parameters, such as, primary dendrite spacing and dendrite trunk diameter. 
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A gradient freeze DS experimental set up consisting of a two zone resistance 

furnace on top, a hollow alumina insulating disk in the middle and a gallium cooling bath 

below was used to directionally solidify about 10 mm diameter Pb-5.8Sb alloy cylinders 

kept in evacuated quartz ampoules by heating the furnace to 650 co. and then cooling the 

hot zone at either at 0.5 
o
C/min or at 4 

o
C/min, while the bottom end of the sample was 

kept at room temperature by the water cooled gallium bath. Ten thermocouples were 

placed along the DS length to record the thermal profile as the liquid-solid interface 

traversed from the cold end to the hot end in response to the decreasing heat input from 

the top. The thermal profiles were used to estimate the thermal gradient and solidification 

speed at various locations along the sample length. Microstructures on the transverse 

sections were examined by cutting several 0.5 mm long transverse disks along the sample 

length. Morphology of primary dendrites was observed to change from being branch-less 

(cellular) in the very beginning of DS, to those showing onset of side-branching, and 

finally to well-branched tree-like structure having tertiary and higher-level side-branches 

as the solidification progressed from the cold to the hot end of the samples. Following 

conclusions can be drawn from this study. 

Gradient Freeze DS method can be used to examine the morphological evolution 

of whole range of dendrite structures, from no branches to extensive branching, using one 

sample processed on the Space Station as compared with several required if one must use 

the steady state DS procedure. 

Freckles (channel segregates) produced by “plume-type” thermosolutal 

convection are seen in the slower cooling rate sample, but not in the faster cooling rate 
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sample. These will not be present in the same alloy samples processed on the Space 

Station.  

Extensive longitudinal macrosegregation of solute occurs during DS. The 

solidified sample, initially solute poor becomes increasingly solute rich along its length. 

The Space Station processed sample will be free of longitudinal macrosegregation.  

The primary dendrite trunk diameter decreases, and the spacing, as measured by 

mean minimum spanning tree branch length or nearest neighbor spacing, increases during 

gradient freeze DS from one end of the sample to the other because of the changing 

thermal gradient and growth speed conditions along the DS length (The growth speed 

appears to increase and thermal gradient appears to decrease).  

The experimentally observed primary spacing (minimum spanning tree and 

nearest neighbor spacing) values are less than those predicted from Hunt-Lu model. It is 

likely caused by the thermosolutal convection in the mushy-zone during DS of this alloy. 

A comparison with data from Space Station Processed samples will help us understand 

the role convection plays in reducing primary dendrite spacing. 

Primary dendrite trunk diameter is larger in the samples than predicted from the 

analytical model which is based on side-branch coarsening under a diffusive mass 

transport conditions [  ]. Again, a comparison with data from Space Station Processed 

samples will help us understand if convection does make trunk diameter coarser. 
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